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Introduction
Présentation de MIDI Song to Style

L’application MIDI Song to Style convertit automatiquement les morceaux MIDI (SMF : fichier MIDI standard ; extension : .mid) en 
fichiers de style (.sty), ce qui vous permet de reproduire les morceaux souhaités en tant que styles sur l’instrument.

Vous pouvez également écouter et modifier les données converties :
- En reproduisant des morceaux MIDI chargés et en modifiant les sonorités affectées à chaque canal.

- En écoutant et en modifiant les styles convertis.

Précautions à prendre lors de l’utilisation de l’application

• Cette application (ci-après dénommée l’« application ») collecte de manière anonyme des données d’utilisation des fonctions 

dans le but d’améliorer la qualité du service et de promouvoir des produits et services associés. Les données réelles que vous 
modifiez ne seront pas collectées. Si vous ne souhaitez pas transmettre le statut d’utilisation, vous pouvez désactiver cette 

option sous Réglages (page 12).

• Cette application a été principalement conçue pour convertir des morceaux MIDI en fichiers de style ; elle n’est pas faite pour 
servir de lecteur audio. Veuillez noter que les fonctions d’aperçu suivantes de l’application servent uniquement de support pour 

effectuer des modifications, et que nous ne garantissons pas l’entière compatibilité de la reproduction audio, etc.

- Reproduction de morceaux MIDI
- Reproduction de styles convertis

• Cette application peut uniquement être utilisée avec les modèles compatibles avec le format SFF GE (par exemple, Genos2).

Ordinateur

Instrument

MIDI Song to Style

Morceau 
MIDI (.mid)

Style
(.sty)

Transfert par câble 
USB ou via lecteur 

flash USB
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Installation
Connexions et installation

Il est possible d’utiliser cette application de deux manières différentes : en la connectant à l’instrument, ou en l’utilisant 
simplement de manière autonome sur un ordinateur.

 Utilisation de l’application en connectant l’ordinateur sur l’instrument
Cette méthode est recommandée, car elle vous permet d’écouter toutes les modifications comme elles seront réellement 

entendues.

Exemple de connexion

Pour obtenir des instructions sur la manière de connecter l’ordinateur à l’instrument, reportez-vous au mode d’emploi 

correspondant.

Lorsque vous vous connectez à l’instrument, vous pouvez :
• Reproduire des fichiers MIDI avec les sons de l’instrument.

• Écouter les styles convertis avec les sons de l’instrument.
• Enregistrer (transférer) les fichiers de style convertis directement dans l’instrument.

• Spécifier des accords sur le clavier de l’instrument tout en écoutant les styles convertis.

Réglages requis :
Ouvrez [Preference] -> [MIDI Device] dans le menu situé en haut de l’application, puis réglez le port comme suit.
• MIDI Input Device : sortie MIDI de l’instrument

• MIDI Output Device : entrée MIDI de l’instrument

NOTE
Lorsque vous spécifiez des accords depuis l’instrument tout en écoutant sur cette application, assurez-vous que la touche [ACMP] de 
l’instrument est désactivée. (Si vous utilisez l’instrument avec les fichiers de style converti chargés, activez [ACMP] comme vous le 
faites habituellement.) 

NOTE
L’entrée et la sortie doivent être toutes deux réglées sur l’instrument pour un transfert correct des fichiers.

Ordinateur

Instrument
Haut-parleurs 

de l’instrument 
ou sortie audio

Câble USBMIDI Output Device

MIDI Input Device
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Installation
 Utilisation de l’application de manière autonome uniquement avec un 
ordinateur
Vous pouvez tout simplement utiliser cette application seule, sans avoir à connecter l’instrument sur l’ordinateur. Cette méthode 
ne permet pas de reproduire aussi fidèlement les sonorités et les styles, mais elle vous permet de travailler uniquement avec 

l’ordinateur.

Exemple de connexion

En vous servant uniquement d’un ordinateur, vous pouvez :
• Reproduire des morceaux MIDI en utilisant les sons de l’instrument virtuel intégré à l’application (*1).
• Écouter des styles convertis avec les sons de l’instrument virtuel intégré à l’application (*1).

• Enregistrer le fichier de style converti sur l’ordinateur ou le transférer vers l’instrument au moyen d’un lecteur flash USB.

• Spécifier des accords sur la palette d’accords (page 13) tout en écoutant les styles convertis.

*1) Les sons ne seront pas reproduits avec une précision irréprochable.

Réglages requis :
Ouvrez [Preference] -> [MIDI Device] dans le menu situé en haut de l’application, puis réglez le port comme suit.
• MIDI Input Device : aucun (réglez si vous disposez d’un clavier MIDI, etc.)

• MIDI Output Device : MIDI Song to Style Synth, ainsi qu’un dispositif audio pour émettre le son

Dispositif 
audio intégré à 

l’ordinateur

Haut-parleurs de 
l’ordinateurInstrument 

virtuel 
intégré

Clavier MIDI, etc.

Ordinateur

MIDI Output Device

MIDI Input Device
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Installation
 Importation de la liste des sonorités
Lorsque vous modifiez les sonorités de chaque canal d’un morceau MIDI préalablement chargé dans cette application (page 25), 
vous pouvez sélectionner des sonorités dans la liste des sonorités intégrée à l’application. La liste des sonorités pour la version 

1.00 du micrologiciel du Genos2 est la liste initialement chargée dans cette application.

En important la liste des sonorités, vous pouvez faire correspondre la liste des sonorités de cette application avec celle de 
l’instrument lié.

Pour les produits compatibles, des informations sur le fichier liste des sonorités pour MIDI Song to Style sont disponibles sur la 

page produit du site Web Yamaha (https://www.yamaha.com/).

1. Sélectionnez [Edit] -> [Import Voice List] dans le menu situé en haut de l’application.
Une fenêtre de sélection de fichier s’ouvre.

2. Sélectionnez la liste des sonorités (.txt) pour votre instrument.
La liste des sonorités de l’application sera mise à jour avec la liste chargée.

Si aucun message d’erreur n’apparait, le chargement est terminé.
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Guide de référence rapide/Présentation
Comment utiliser MIDI Song to Style

 Mode d’utilisation le plus simple : conversion et transfert

1. Faites un glisser-déposer du fichier SMF vers MIDI Song to Style.

Le morceau MIDI que vous avez transféré est automatiquement analysé et converti en style, ce qui vous permet de 

reproduire et de modifier le style converti dans l’application (page 16).

2. Transférez les résultats de l’analyse vers l’instrument sous forme de fichier de style. (Cliquez 
sur l’icône )
Il existe deux méthodes de transfert :

A) Enregistrez le fichier de style directement dans l’instrument au moyen du câble USB (Enregistrer dans 
l’instrument).
(Vous pouvez transférer le fichier lorsque l’ordinateur est connecté à l’instrument via un câble USB. Reportez-vous à 

la page 3 pour les réglages nécessaires.) 

B) Enregistrez sous forme de fichier de style sur un lecteur flash USB, puis transférez le fichier vers 
l’instrument (Enregistrer sur l’ordinateur).

3. Jouez sur l’instrument avec le style transféré.

1 2

Ordinateur

MIDI Song to Style

Morceau 
MIDI (.mid)

Style
(.sty)

Transfert par câble 
USB ou via lecteur 

flash USB

Instrument

Fichier de morceau MIDI
Format de fichier MIDI standard 
(.mid)
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Guide de référence rapide/Présentation
 Nouvelle analyse en modifiant les conditions d’analyse
Si les résultats de la conversion de style automatique ne sont pas à la hauteur de vos attentes, vous pouvez modifier les 
conditions de l’analyse et reconvertir le morceau MIDI chargé.

• Veillez à exclure le canal mélodique principal ainsi que les autres canaux que vous ne souhaitez pas inclure dans le style (page 19).

 Modification du style automatiquement converti
Vous pouvez modifier manuellement le style automatiquement converti comment suit.

• Modifier la plage extraite d’un morceau MIDI en tant que section (page 20) 
• Réorganiser les sections (page 21) 

• Sélectionner une nouvelle plage et l’affecter à une section (page 22) 

• Modifier les affectations de canaux MIDI de chaque partie de style pour chaque section (page 24) 
• Modifier la sonorité pour chaque canal d’un morceau MIDI (page 25) 

• Modifier/réinitialiser le volume pour chaque partie d’un style (page 26) 

• Modifier le temps du style ou l’indication de la mesure (page 26)
7



Guide de référence rapide/Présentation
Enregistrement ou chargement des données en cours de modification (projet)

Vous pouvez enregistrer ou charger les morceaux MIDI chargés, y compris les informations analysées et les contenus modifiés, 
sous forme de fichier de projet dans un format de fichier dédié (.sts).

Les contenus suivants sont enregistrés dans le fichier de projet :
• Contenu du morceau MIDI chargé (fichier SMF)

• Résultats de l’analyse automatique d’un morceau MIDI

• Statut de modification du style, y compris les affectations de sections et de parties

 Enregistrement d’un projet
Ouvrez [File] -> [Save Project] dans le menu situé en haut de l’application, et spécifiez l’emplacement de sauvegarde.

 Chargement d’un projet
Ouvrez [File] -> [Open Project] dans le menu situé en haut de l’application, et sélectionnez le fichier de projet souhaité. Vous 

pouvez également simplement faire un glisser-déposer du fichier de projet dans l’application.
8



Fonctions (description de l’affichage)
Flux d’affichage

Voici une présentation succincte du flux d’affichage après démarrage de l’application.

Au démarrage

Réglages MIDI

Autres réglages

Accueil (Easy)

Palette d’accords (fenêtre séparée)

Accueil (Edit)

Enregistrement des styles

Modification détaillée (fenêtre séparée)

Modification des paramètres de section

Chargement du fichier

Changement de mode
9



Fonctions (description de l’affichage)
Fonctions de l’affichage

Cette section décrit ce qu’il est possible de faire sur chacun des écrans présentés précédemment.

 Écran d’accueil (Easy)

q Contrôle la reproduction de morceau MIDI

w Ouvre l’écran de chargement d’un nouveau fichier

e Change le mode d’affichage d’accueil (Easy  Edit)

r Ouvre la fenêtre de réglages MIDI (page 12)

t Ouvre la fenêtre des autres réglages (page 12)

y Pour reproduire des sections du style converti (page 16)

u Affiche l’accord spécifié durant la reproduction du style et ouvre la fenêtre de palette d’accords 
(page 13)

i Ouvre l’écran d’enregistrement de style (page 18) 

q

t

y

e

r

w

u

i
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Fonctions (description de l’affichage)
 Écran d’accueil (Edit)

Les fonctions q à i sont identiques à celles de l’écran d’accueil (Easy).

o Effectue une nouvelle analyse après modification des réglages d’analyse automatique (page 19).

!0 Contrôle et actionne chaque canal pour la reproduction du morceau MIDI.
• Affiche le type général de sonorité (affichage uniquement).

• Détermine le réglage activé/désactivé (assourdissement) pour chaque canal.

!1 Affiche l’aperçu des données du morceau MIDI et vous permet de modifier les sections de 
style.
• Affiche l’aperçu des données de chaque canal pour un morceau MIDI (affichage uniquement).

• Modifie la section de style (page 20).
• Modifie l’affectation de canal MIDI pour chaque partie de style (page 24).

!2 Modifie l’agrandissement de l’affichage de l’aperçu des données de morceau MIDI (!1).

!3 Affiche un certain nombre de réglages de style et vous permet de les modifier (pages 17, 26).
• Tempo (affichage uniquement)

• Indication de la mesure (temps)
• Activation/désactivation et volume de chaque partie de style

• Touche de section

!3

u

!1

!2

t

y

r

e

!0

qo wi
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Fonctions (description de l’affichage)
 Affichage des réglages MIDI

q Détermine MIDI Input Device.

w Détermine MIDI Output Device.
Si vous sélectionnez « MIDI Song to Style Synth », vous devrez également régler la destination de sortie audio.

e Actualise la liste de périphériques MIDI.

 Affichage des autres réglages

q Détermine la taille maximum des fichiers de style convertis.

w Détermine si la fenêtre de palette d’accords (page 13) est automatiquement appelée lors de la 
reproduction d’un style.

e Détermine s’il faut autoriser ou non la collecte de données anonymes relatives au statut 
d’utilisation de cette application.

w

q

e

q

w

e
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Fonctions (description de l’affichage)
 Fenêtre de palette d’accords
Cette fenêtre vous permet de spécifier l’accord utilisé lorsque le style est reproduit.

q Spécifie la note fondamentale de l’accord.

w Spécifie le type d’accord.
L’abréviation « cc » signifie « chord cancel » (annulation d’accord) (aucun accord spécifié).

e Active/désactive l’accord On Bass et vous permet de spécifier la note de basse.

r Affiche l’accord spécifié.

e

w

r

q
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Fonctions (description de l’affichage)
 Fenêtre de modification détaillée
Cette fenêtre vous permet de modifier les réglages de canaux du morceau MIDI et de changer les réglages détaillés pour chaque 
partie de la section de style.

q Contrôle la reproduction du morceau MIDI.

w Active/désactive (assourdit) chaque canal MIDI.

e Réinitialise les réglages de canaux MIDI.
Rétablit le statut avant modification.

r Détermine la sonorité de chaque canal MIDI.
Vous pouvez la spécifier en sélectionnant des numéros de changement de programme ou des noms de sonorité.

La liste des sonorités importée (page 5) est utilisée pour le nom de sonorité.

Les couleurs attribuées aux numéros de sonorité ou aux noms de sonorité indiquent les conditions suivantes.

t Détermine le volume de chaque canal MIDI.

Touches 
blanches

Non modifié et la sonorité ne changera pas durant la 
séquence.

Jaune Non modifié et la sonorité changera durant la séquence.

Orange La sonorité a été réglée manuellement.

ew q

i u t y

r
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Fonctions (description de l’affichage)
y Affiche le statut de volume de chaque canal MIDI.
Les trois types de conditions de volume sont indiqués comme suit.

u Réinitialise tous les réglages de canaux MIDI.

i Affiche le statut d’affectation de chaque canal pour la section et appelle les réglages détaillés 
des parties de style.
Affiche les affectations des parties pour chaque canal dans chaque section du style.
Les abréviations suivantes sont utilisées sur l’affichage.

Nom de section

Nom de la partie de style

Cliquez sur chaque nom de partie de style pour modifier les paramètres détaillés des parties dans chaque section.
Pour plus d’informations sur les paramètres détaillés, reportez-vous à la page 29.

Touches 
blanches

Non modifié et le volume ne changera pas durant la séquence.

Jaune Non modifié et le volume changera durant la séquence.

Orange Le volume a été réglé manuellement.

I1 à 3 Intro I à III

MA à MD Main A à D

FA à FD Fill In A à D

BK Break

E1 à E3 Ending I à III

R1, R2 Rhy1, Rhy2

Bs Bass

C1, C2 Chd1, Chd2

Pd Pad

P1, P2 Phr1, Phr2

NOTE
Les paramètres détaillés sont automatiquement réglés en fonction des résultats d’analyse ; par conséquent, il n’est normalement 
pas nécessaire de les modifier.
15



Comment utiliser l’application
Reproduction (écoute) du style converti

Vous pouvez écouter le rendu sonore du style converti tout en spécifiant l’accord.

 Reproduction de styles

1. Cliquez sur l’icône de la section que vous souhaitez reproduire.

L’icône de la section s’affiche (en surbrillance) lors de la reproduction, et la section est reproduite en boucle.

Dans cet exemple, la section Main B est reproduite.

En outre, la fenêtre de palette d’accords (page 13) est automatiquement appelée par défaut.

2. Contrôlez la reproduction du style, par exemple en modifiant des sections et en spécifiant des 
accords.
• Si vous cliquez sur l’icône d’une autre section, cette section sera reproduite.

• Vous pouvez vérifier le changement de son tout en spécifiant l’accord depuis la fenêtre de palette d’accords ou depuis 
l’instrument préalablement réglé comme MIDI Input Device.

3. Cliquez sur l’icône de la section en cours de reproduction pour interrompre la reproduction 
du style.

Activation/désactivation de la reproduction en boucle de la section.
Par défaut, cette application est réglée de sorte que chaque section soit reproduite en boucle, ce qui vous permet de vérifier 
les contenus du style. Ce comportement diffère de celui des instruments habituellement dotés de la fonction style. Si vous 

souhaitez modifier le comportement des sections qui ne sont normalement pas reproduites en boucle (Intro I à III, Fill In A à D, 

Break et Ending I à III) de sorte qu’elles ne soient pas reproduites en boucle, cliquez sur le signe  situé dans le coin supé-
rieur droit de l’icône. L’affichage passe à  (reproduction en boucle désactivée) et ces sections ne seront reproduites qu’une 

seule fois, puis le style sera reproduit comme c’est habituellement le cas pour les claviers numériques dotés de la fonction 

style.
16



Comment utiliser l’application
 Activation/désactivation de chaque partie de style pendant la reproduction
Sur l’écran d’accueil (Edit), vous pouvez activer/désactiver (assourdir) chaque partie.

Cliquez sur le nom de chaque partie de style pour l’activer/la désactiver.

Les parties désactivées seront grisées.

Dans cet exemple, Chd1 et Chd2 sont désactivées.
17



Comment utiliser l’application
Enregistrement et transfert des styles convertis

Vous pouvez enregistrer les résultats de conversion sur l’ordinateur ou les transférer sur l’instrument connecté sous forme de 
fichier de style (.sty).

1. Cliquez sur l’icône .

2. Sélectionnez la méthode d’enregistrement souhaitée pour le fichier.
• [Save to Instrument] : Ceci transfère et enregistre les fichiers de style directement dans l’instrument.

Le fichier sera enregistré dans le dossier racine du lecteur utilisateur.

• [Save to Computer] : Ceci enregistre les fichiers de style sur l’ordinateur.

3. Suivez les instructions à l’écran pour procéder à l’enregistrement ou au transfert.
A) Pour [Save to Instrument] (transfert direct vers l’instrument)

Entrez un nom puis cliquez sur [Save to Instrument] pour démarrer le transfert.

B) Pour [Save to Computer] (enregistrement sur un ordinateur)
Lorsque la boîte de dialogue d’enregistrement de fichier s’affiche, entrez un nom et enregistrez-le à l’emplacement 

souhaité.

Utilisez un lecteur flash USB pour transférer les données vers l’instrument.

NOTE
Si vous souhaitez annuler l’enregistrement, cliquez à nouveau sur l’icône .

NOTE
Vous pouvez utiliser [Save to Instrument] uniquement lorsque l’ordinateur est connecté à l’instrument au moyen d’un câble USB. 
Pour obtenir des instructions, reportez-vous à la page 3.
18



Comment utiliser l’application
Modification des présélections d’analyse automatique

Les conditions d’analyse des morceaux MIDI sont réglées automatiquement, mais cela peut entraîner des résultats décevants en 
fonction des données MIDI particulières. Il est possible de modifier le réglage afin d’inclure ou non chaque canal dans l’analyse ; 

vous pourrez ainsi analyser à nouveau les données et obtenir les résultats souhaités.

 Spécifiez manuellement les canaux que vous souhaitez exclure de l’analyse, puis 
procédez à une nouvelle analyse

1. Réglez l’écran d’accueil en mode Edit.

2. Cliquez sur [Reanalyze Setting].

L’affichage des réglages d’analyse est appelé.

3. Modifiez les réglages d’exclusion de canaux comme vous le souhaitez.

Cochez les cases des onglets [Melody] et [Assign] comme nécessaire.
• Onglet [Melody] : Les canaux cochés seront considérés comme « mélodie principale ».

Les canaux mélodiques principaux sont utilisés pour estimer la plage de section.

Lorsque vous cochez l’onglet [Melody], l’onglet [Assign] se décoche automatiquement.
Pour la valeur initiale, les résultats de l’identification automatique de la mélodie principale sont affichés.

Cochez les canaux que vous souhaitez spécifier pour la mélodie principale (par exemple, le canal contenant les 

notes que vous souhaitez reproduire).
• Onglet [Assign] : Les canaux cochés sont les parties qui peuvent être affectées aux parties de style.

Si vous ne souhaitez pas inclure le son de performance d’un canal spécifique dans le style converti, décochez ce 

canal.

4. Cliquez sur [Reanalyze] pour réaliser une nouvelle analyse.
Les résultats de conversion seront mis à jour.
19



Comment utiliser l’application
Modification du style converti

En mode Edit (page 11) sur l’écran d’accueil, vous pouvez modifier un style automatiquement converti si cela est nécessaire afin 
d’obtenir le résultat de conversion souhaité.

 Modification de la plage des sections

1. Cliquez sur le nom de la section en haut de l’affichage et sélectionnez la section dont vous 
souhaitez modifier la plage.

La section sélectionnée est mise en surbrillance. Dans cet exemple, Intro II a été sélectionnée.

2. Faites glisser l’extrémité droite ou gauche de la plage de section pour ajuster la plage comme 
souhaité.

La plage de la section a été modifiée.

NOTE
Les opérations de modification présentées dans ce chapitre peuvent être annulées ou rétablies à l’aide de [Edit] -> [Undo]/[Redo] dans le 
menu situé en haut de l’application.
20



Comment utiliser l’application
 Réorganisation des sections
Si les résultats d’affectation automatique des sections n’apparaissent pas dans l’ordre souhaité, vous pouvez réorganiser les 
sections.

1. Cliquez sur le nom de la section en haut de l’affichage afin de sélectionner la section que 
vous souhaitez repositionner.

La section sélectionnée est mise en surbrillance. Dans cet exemple, Main D est sélectionnée.

2. Cliquez à nouveau sur le nom de la section sélectionnée.

La fenêtre contextuelle d’affectation de sections est appelée.

3. Sélectionnez le nom de la section souhaitée comme destination de remplacement, puis 
cliquez sur [Assign] pour confirmer.

L’affectation de la section a été modifiée. Dans cet exemple, Main A et Main D ont été repositionnées.

NOTE
Vous pouvez conserver un effet naturel en repositionnant la section Main et la section Fill In comme un ensemble.

Pour maintenir une sensation naturelle, repositionnez la section Main et la section Fill In comme un ensemble. Par exemple, lorsque 
vous remplacez Main B par Main C, vous devriez également remplacer Fill B par Fill C pour assurer la cohérence entre les motifs.
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Comment utiliser l’application
 Affectation (manuelle) d’une nouvelle section
Vous pouvez spécifier la plage que vous souhaitez affecter à une nouvelle section.

1. Sur l’affichage, sélectionnez la plage que vous souhaitez affecter.

La plage sélectionnée s’affiche.

2. Cliquez sur .

La fenêtre contextuelle d’affectation de sections est appelée.

3. Sélectionnez le nom de la section à laquelle vous souhaitez affecter la plage sélectionnée, 
puis cliquez sur [Assign] pour confirmer.
• Lorsque vous sélectionnez une section n’ayant encore aucune affectation, une nouvelle section est ajoutée.
• Lorsque vous sélectionnez une section dotée d’affectations existantes, la section existante est supprimée et remplacée 

par la nouvelle plage.

Dans cet exemple, la plage sélectionnée vient d’être ajoutée en tant que Intro I.
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Comment utiliser l’application
 Suppression de sections
Vous pouvez supprimer les sections inutiles.

1. Cliquez avec le bouton droit de la souris sur le nom de la section que vous souhaitez 
supprimer.

Ceci appelle un menu de suppression.

2. Cliquez sur [Delete <nom de la section>].
La section est alors supprimée.
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Comment utiliser l’application
 Modification de la combinaison parties/canaux MIDI au sein d’une section
L’affectation pour laquelle des canaux MIDI individuels sont convertis en parties de style spécifiques peut être modifiée 
indépendamment pour chaque section.

1. Cliquez sur le nom de la section en haut de l’affichage afin de sélectionner la section que 
vous souhaitez modifier.

Le statut d’affectation du canal pour chaque partie de la section sélectionnée s’affiche.

2. Faites un glisser-déposer de la partie dont vous souhaitez modifier l’affectation.

La partie source et la partie destination du glisser-déposer ont été repositionnées.

Suppression ou ajout de parties à l’intérieur d’une section
Vous pouvez supprimer une affectation de partie en cliquant sur l’icône [-] à côté du nom de la partie.

Une icône [+] s’affiche pour les canaux sans affectation dont les données de performances entrent dans la plage de la section.

Cliquez sur cette icône [+] pour sélectionner et affecter une partie de section.
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Comment utiliser l’application
 Modification de la sonorité pour chaque canal d’un morceau (modification 
détaillée)
Vous pouvez remplacer les sonorités génériques spécifiées dans un morceau MIDI par des sonorités de meilleure qualité 
spécifiques à l’instrument.

1. Sélectionnez [Edit] -> [Open DetailEdit  Window] dans le menu situé en haut de l’application.
La fenêtre de modification détaillée est appelée.

2. Modifiez les réglages de sonorité pour chaque canal.

Vous pouvez les régler en utilisant des numéros de changement de programme ou des noms de sonorité.

La liste des sonorités importée (page 5) est utilisée pour le nom de sonorité.
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Comment utiliser l’application
 Modification/réinitialisation du volume pour chaque partie d’un style
Vous pouvez modifier le volume de chaque partie de style dans toutes les sections.

Pour ajuster le volume de chaque partie, utilisez les boutons situés sous les noms de parties de style. Vous pouvez également 

modifier directement les valeurs.

Si vous souhaitez réinitialiser le volume modifié pour le ramener à son statut initial (l’état dans lequel il se trouvait lors du 

chargement du morceau MIDI), effectuez l’une des opérations suivantes :
• Dans le menu situé en haut de l’application, ouvrez [Edit] -> [Reset Style Parameter] -> [Volume], puis sélectionnez la partie 

que vous souhaitez réinitialiser.

• Maintenez la touche CTRL (Windows) ou Command (Mac) enfoncée, et cliquez sur le bouton correspondant à la partie que 
vous souhaitez réinitialiser.

Si vous souhaitez restaurer la modification précédemment annulée, sélectionnez [Edit] -> [Undo].

 Modification du temps du style (indication de la mesure)
Vous pouvez modifier les réglages de temps du style (indication de la mesure) une fois la conversion réalisée.

Cliquez sur la zone « Beat » en bas de l’écran et réglez la valeur.

 Modification de la touche de section de style
Section key (Section Key Signature) est un paramètre qui indique sur quelle touche sont basées les données de chaque section.
Si vous spécifiez des accords ayant la même note fondamentale que cette touche pendant la reproduction de style, les sections 

Intro et Ending seront reproduites avec la même hauteur de son que le morceau MIDI avant la conversion. Sélectionnez le nom 

de la section que vous souhaitez modifier en haut de l’affichage, puis cliquez dans la zone « Section Key » en bas de l’affichage 
pour régler la valeur.
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Annexe
Terminologie

 Morceaux MIDI (SMF)
• Données de partition musicale au format électronique. Le fait de charger de telles données dans un périphérique compatible 

permet de reproduire la musique.
• Inclut 16 « canaux » vous permettant de spécifier plusieurs sonorités (son d’instruments), volumes et performances.

• SMF (fichier MIDI standard) (.mid) est le nom du format standard pour les fichiers MIDI.

 Termes relatifs au style
Section :
Groupe collectif de données musicales (ou motifs) utilisé pour élaborer un morceau.

En fonction de la progression de la performance ou du morceau, les sections changent de manière automatique ou manuelle.
Les sections incluent Intro I-III, Main A-D, Fill In A-D, Break et Ending I-III.

Exemple de reproduction :

Partie :
Composante d’une section. Les sonorités, etc. peuvent être réglées individuellement pour chaque section. Les parties équivalent 

aux canaux dans un morceau MIDI.
Les parties incluent Rhythm 1-2, Bass, Chord 1-2, Pad et Phrase 1-2.

Fichier de style : 
Le format de fichier de style (SFF) est un format lié à la fonction d’accompagnement automatique de Yamaha (style).

Il existe deux formats : SFF et SFF GE.

SFF GE (Guitar Edition) est un format étendu du SFF qui renforce l’expressivité des sonorités de guitare.
MIDI Song to Style exporte les fichiers de style au format SFF GE.

NOTE
Lors de la conversion automatique dans MIDI Song to Style, il reste toujours certaines sections (Intro I, Break, Ending I, Ending III) sans 
affectation ; il est donc nécessaire (et souhaitable) de les affecter manuellement.

Opération

Reproduction de style

INTRO
[I]

START/
STOP

MAIN
[B]

ENDING
[II]

Stop
Intro I

(une fois)
Main A

(en boucle)
Fill In B

(une fois)
Main B

(en boucle)
Ending II
(une fois)

Main A

Rhythm 1

Rhythm 2

Bass

Chord 1

Chord 2

Pad

Phrase 1

Phrase 2

Main B

Rhythm 1

Rhythm 2

Bass

Chord 1

Chord 2

Pad

Phrase 1

Phrase 2
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Annexe
Liste des menus

* Sur la version pour Mac, ce menu se trouve dans le menu de l’application « MIDI Song to Style ».

Menu Description

File

Open SMF Charge les fichiers de morceau MIDI (.mid, .midi).

Save Style File Enregistre le fichier de style converti sur l’ordinateur.

Open Project
Charge le fichier de projet (.sts) et reproduit le statut de modification au moment de 
l’enregistrement.

Save Project
Enregistre le projet en cours de modification dans un fichier de projet au format 
propriétaire (.sts).

Recent Files Sélectionne les fichiers récemment ouverts.

Exit (Quit)* Quitte l’application.

Edit

Undo Rétablit le statut de modification précédent.

Redo Après avoir utilisé Undo, rétablit le statut de modification avant annulation.

Open DetailEdit Window Ouvre la fenêtre de modification détaillée.

Import Voice List

Importe la liste des sonorités.

NOTE
La liste des sonorités est utilisée lorsque vous spécifiez des sonorités dans la fenêtre 
de modification détaillée.

Reset Style Parameter Volume Réintialise le volume pour chaque partie du style.

Help

Manual Affiche le mode d’emploi (ce manuel).

Privacy Statement Affiche la politique de confidentialité.

About*
Affiche la version de l’application ainsi que les informations relatives aux droits 
d’auteur.
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Annexe
Raccourcis clavier

Fenêtre de modification détaillée : modification des paramètres de 
section

La fenêtre de modification des paramètres de section est appelée lorsque vous cliquez sur une partie dans une section dans la 

fenêtre de modification détaillée (page 14).

Opération Raccourci

Charger un fichier de morceau MIDI (.mid) Ctrl + Maj + O

Enregistrer un fichier de style (.sty) Ctrl + Maj + S

Charger un fichier de projet (.sts) Ctrl + O

Enregistrer un fichier de projet (.sts) Ctrl + S

Annuler Ctrl + Z

Rétablir Ctrl + Maj + Z

Ouvrir l’affichage de modification détaillée Ctrl + Maj + D

Reproduire/interrompre un morceau MIDI Barre d’espacement

NOTE
• Il est possible que les raccourcis clavier ne soient pas immédiatement disponibles après avoir entré des chiffres sur le clavier. Le cas 

échéant, cliquez une fois n’importe où sur l’écran pour activer les raccourcis.

• Sur Mac, utilisez la touche Command au lieu de la touche Ctrl.
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Annexe
 Descriptions de chaque élément de l’affichage

Nom de l’élément Description

Section Setting Change la section à modifier.
Pour cet élément uniquement, le nom de section diffère de l’affichage normal. 
Remplacez les noms de sections par ce qui suit lorsque vous voyez :
• Intro A-C : Intro I-III
• Fill In AA-DD : Fill In A-D
• Fill In BA : Break
• Ending A-C : Ending I-III

Key Signature Détermine la Section Key Signature.

Channel Setting Change le canal MIDI devant être modifié dans la section sélectionnée.

Attribute Affiche les attributs du canal (résultats d’analyse automatique).

Style Part Affiche l’affectation de partie du canal sélectionné dans une section.

Zone Setting Divise la zone et définit le fonctionnement des canaux qui apparaissent au-
dessus (parties de style affectées aux canaux) sur une plage de section.

Lo Zone Split Détermine où séparer la Lo Zone et la Main Zone.
Entre la valeur de touche la plus basse (-, 1 à 127) de la Main Zone.
Si la valeur affiche « - », les réglages de la Lo Zone sont désactivés.

Style Playing 
Parameter

Affiche le Style Playing Parameter pour la Lo Zone (le réglage et les 
modifications automatiques ne sont pas autorisés).

Convert to Style 
Parameter

Détermine les règles de conversion des notes pour la Lo Zone lors de la 
conversion vers un style.
Il existe quatre options : Root only, Active for Main, Semi-active Bass et -.

HiKey
(High Key)

Détermine la valeur standard (0 à 11 : C à B) pour déterminer s’il faut transposer 
vers le haut ou vers le bas lors de la reproduction du style pour la Lo Zone.
Si une note plus haute que cette valeur est spécifiée comme note fondamentale 
d’accord pendant la reproduction, la transposition se fera vers le bas.

LoLim
(Low Limit)

Détermine la valeur de transposition minimum (0 à 127) pendant la reproduction 
de style pour la Lo Zone.
Si le résultat du calcul de transposition devient inférieur à cette valeur pendant la 
reproduction, des actions telles que la répétition d’octave ou l’interruption du son 
seront effectuées en fonction du Style Playing Parameter.

HiLim
(High Limit)

Détermine la valeur de transposition maximum (0 à 127) pendant la 
reproduction de style pour la Lo Zone.
Si le résultat du calcul de transposition devient supérieur à cette valeur pendant 
la reproduction, des actions telles que la répétition d’octave ou l’interruption du 
son seront effectuées en fonction du Style Playing Parameter.
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Annexe
Zone Setting Main Zone Style Playing 
Parameter

Détermine le Style Playing Parameter pour la Main Zone.

Convert to Style 
Parameter

Détermine les règles de conversion des notes pour la Main Zone lors de la 
conversion vers un style.

HiKey 
(High Key)

Détermine la valeur standard (0 à 11 : C à B) pour déterminer s’il faut transposer 
vers le haut ou vers le bas lors de la reproduction du style pour la Main Zone.
Si une note plus haute que cette valeur est spécifiée comme note fondamentale 
d’accord pendant la reproduction, la transposition se fera vers le bas.

LoLim 
(Low Limit)

Détermine la valeur de transposition minimum (0 à 127) pendant la reproduction 
de style pour la Main Zone.
Si le résultat du calcul de transposition devient inférieur à cette valeur pendant la 
reproduction, des actions telles que la répétition d’octave ou l’interruption du son 
seront effectuées en fonction du Style Playing Parameter.

HiLim 
(High Limit)

Détermine la valeur de transposition maximum (0 à 127) pendant la 
reproduction de style pour la Main Zone.
Si le résultat du calcul de transposition devient supérieur à cette valeur pendant 
la reproduction, des actions telles que la répétition d’octave ou l’interruption du 
son seront effectuées en fonction du Style Playing Parameter.

Hi Zone Mega Voice Détermine s’il faut appliquer un traitement MegaVoice sur les notes de la Hi 
Zone (C6 ou supérieures).
Les notes C6 ou supérieures cochées ne seront pas converties et continueront à 
être jouées correctement lors de l’utilisation de MegaVoice.

Nom de l’élément Description
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Annexe
 À propos de Style Playing Parameters
Il n’existe pas de règles de conversion des notes permettant à chaque partie d’une section de correspondre à une spécification 
d’accord pendant la reproduction du style.

Le fait de choisir des présélections correspondant aux caractéristiques de chaque partie garantira la qualité et la précision de 

votre performance.

 À propos de Convert to Style Parameters
Voici les règles qui s’appliquent à la conversion des notes des canaux en notes des parties de style.

Nom de la présélection Description

Bass Pour la partie de basse de la section Main/Fill.

Bass (Intro) Pour la partie de basse de la section Intro/Ending.

Chord Pour une partie principalement composée d’accords de plusieurs notes de la section Main/Fill.

Phrase chordal
Pour une partie principalement composée d’une seule note, d’accords dispersés (arpèges, etc.) de la section 
Main/Fill.

Phrase melodic Pour une partie principalement composée de phrases mélodiques d’une seule note de la section Main/Fill.

Guitar Stroke
Pour une partie utilisant une sonorité de guitare et principalement composée d’accords de plusieurs notes de 
la section Main/Fill.

Guitar Arpeggio
Pour une partie utilisant une sonorité de guitare et principalement composée d’une seule note, d’accords 
dispersés (arpèges, etc.) de la section Main/Fill.

Chromatic Pour une partie principalement composée de phrases de gamme chromatique de la section Main/Fill.

Maj-min (Intro) Pour une partie autre que la partie de basse et Phr1-2, de la section Intro/Ending.

Drum with cymbal Pour une partie utilisant un kit de batterie avec cymbale crash.

Drum no cymbal Pour une partie utilisant un kit de batterie sans cymbale crash.

SFX Pour une partie utilisant un kit SFX.

- Aucune affectation (s’il n’y a aucune affectation de partie).

NOTE
Les parties réglées sur Bass (Intro) ou Maj-min (Intro) sont fortement influencées par la touche de section de cette partie.

Nom de la présélection Description

no change Les notes ne seront pas modifiées.

Root only Seule la note fondamentale de l’accord est reproduite.

Root & 5th Seule la note fondamentale de l’accord et la quinte parfaite sont reproduites.

Semi-active Bass
La performance d’origine est reproduite avec certaines limites éventuelles. 
La stabilité générale et la pertinence des spécifications d’accords pendant la 
reproduction de style peuvent être inférieures à celles de « Root Only ».

Stable for Main

Certains accords spécifiques de plusieurs notes peuvent être reproduits de 
manière stable pendant la reproduction de style.
Cependant, la performance d’origine risque de ne pas être reproduite 
fidèlement.

Active for Main
Si les résultats d’analyse d’accord sont adéquats durant l’analyse, la 
performance d’origine sera fidèlement reproduite. En cas d’erreurs dans les 
résultats d’analyse d’accord, le style converti sera inapproprié musicalement.

Guitar Stroke Réglages propres à « Guitar Stroke ».

Guitar Arpeggio Réglages propres à « Guitar Arpeggio ».
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Annexe
 Restrictions relatives aux options Convert to Style Parameter
Les options Convert to Style Parameter changent en fonction des réglages Style Playing Parameter, comme indiqué dans le 
tableau ci-dessous.

Style Playing Parameter

Bass
Bass 
(Intro)

Chord
Phrase 
chordal

Phrase 
melodic

Guitar 
Stroke

Guitar 
Arpeggio

Chromatic, 
Maj-min (Intro), 
Drums with cymbals, 
Drums without 
cymbals, SFX

Convert to Style 
Parameter 

no change  

Root only   

Root & 5th  

Semi-active 
Bass



Stable for 
Main

  

Active for 
Main

   

Active root 
only

 

Active root & 
5th

 

Guitar Stroke 

Guitar 
Arpeggio
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Annexe
Dépistage des pannes

Si l’application ne fonctionne pas correctement, vérifiez les points suivants pour déterminer si les mesures simples suggérées 
permettent de corriger le problème.

Problèmes Causes possibles Solutions

Impossible d’enregistrer (de transférer) des 
fichiers dans l’instrument bien que 
l’application soit connectée à l’instrument.

Aucun instrument n'est réglé pour MIDI 
Input/Output Device.

Assurez-vous que l’instrument connecté est 
correctement réglé sur MIDI Input/Output 
Device dans les réglages.

Impossible de spécifier des accords depuis 
l’instrument pendant l’aperçu de style, bien 
que l’application soit connectée à 
l’instrument.

L’[ACMP] est activé côté instrument. 
Lorsque l’[ACMP] est activé, les informations 
relatives aux accords sont uniquement 
envoyées à l’instrument, et pas à 
l’ordinateur.

Désactivez l’[ACMP] sur l’instrument.

L’affichage de l’application s’assombrit. La fenêtre est maximisée. Si vous utilisez 
l’application avec la fenêtre maximisée, une 
distorsion risque de se produire dans les 
autres fenêtres en raison du fonctionnement 
du système d’exploitation.

• Appuyez sur la touche [ESC] pour annuler 
la maximisation de la fenêtre.

• Utilisez l’application sans maximiser la 
fenêtre.
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